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Chapter 1

Modeling by tearing and zooming

A typical system consists of an interconnection of subsystems. The very first
picture that comes to mind when thinking about a model is that of a black box
with a number of terminals, say T. Terminals correspond physically to the way in
which the subsystem is interfaced with its environment.
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Figure 1.1: Black box

This can be formalized mathematically, by associating to the i-th terminal a

variable s, which takes its value in a set S2. The set of all terminal variables
S = S x S2 x ... x ST we can think of as the system's terminal signal space.

We are mainly interested in dynamical systems, in which case the terminal
variable s evolves as a function of independent variables, such as time and space,
which we indicate by a set I, the so called indexing set of our model. So s is a
function from lE to S. A priori all functions s : I —* S. denoted by SI, can occur
at the terminals. We can think of S' as the universum of our model, the set of
all possible outcomes. The internal laws of the system restricts this set to a set
B C S". This set B represents the set of signals that actually can occur and is
called the terminal behavior or full behavior.

An interconnected system is viewed as a collection of modules with termi-

4



nals, interconnected through an interconnection architecture. These modules, the
building blocks of an interconnected system, are subsystems with terminals. One
cannot connect terminals that are not of adapted type, i.e. that are not connectable.
For instance, let us consider a physical system. In this case, connectability simply
means that the terminals have to possess the same physical nature (e.g. you cannot
connect an outlet of a tank to an electrical wire). But we do not have to constrict
ourselves to physical systems! See also [4].

Figure 1.2: Interconnected system

A module belongs to a particular module class, which is defined by the num-
ber of terminals, the type of each of its terminals, its behavioral representation and
by parameters. The architecture imposes relations between the variables at these
terminals. Examples of modules classes:

module class Terminals Type of terminals
resistor (terminal!, terminal2) (electrical, electrical)

transistor (collector, emitter, base) (electrical, idem, idem)
2-inlet vessel (inlet 1, inlet2) (fluidic, fluidic)

Examples of terminals:

Type of terminal Variables Universum
electrical (voltage, current) R x R

1-D mechanical (force, position) R x R
2-D mechanical (position, attitude, force, torque) R2 x x x R

thermal (temperature, heat flow) ]R x IR

After interconnection, the architecture leaves some terminals available for in-
teraction with the environment of the overall system. These terminals are the so
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called external terminals. The connected terminals are called internal terminals.

A specific module is defined by giving its module class and the numerical
values of the parameters; the full behavior of both internal and external terminals
is then also defined. However, only some of these variables are of interest for the
specific application at hand. We call these variables the manifest variables taking
values in a signal space W. The remaining variables are called the latent variables
taking values in another signal space L (see e.g. [5], [1]). Usually, the variables on
the external terminals are considered to be manifest; the variables on the internal
terminals are considered to be latent. Now define the manifest behavior

For instance, consider an electrical module, shown in figure 1.3. The interaction
with the environment takes place through its wires. So the wires are the terminals.
With each terminal we associate two real variables, the potential V and the current
I (agreed to be positive when electrical current flows into the device). The laws
of the device specify the behavior, which is a subset of SR where S = (R2)12 is
the signal space and n denotes the number of terminals.

Pairing of terminals by the interconnection architecture implies an interconnec-
tion law. Examples:

6

= {w E W I there exists I E L such that(w, I) E fu1l}

(V,I)

(V1,11) (V3,13)

Figure 1.3: Electrical module

(V2,12)



Pair of
terminal

Variables
terminal 1

Variables
terminal 2

Interconnection
constraints

electrical (V1,11) (v2,12) V1=V2,11+12=O
1-Dmechanical (Fi,q1) (F2,q2) F1+F2 =O,q1 =q2

thermal (Q1,T1) (Q2,T2) Q1+Q2=O,T1 =T2
fluidic (pi, fi) (P2, f2) Pi = P2, Ii + 12 = 0

information processing rn-input u rn-output y u = y

Example: consider the electrical circuit shown in figures 1.4 and 1.5.

Figure 1.4: RLC circuit

R
1-•- 2

RL
4

C L7--8

1

Figure 1.5: RLC circuit after tearing

This circuit consists of the following modules:
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Module From module class Terminals Parameter
R resistor (1,2) R in ohms
RL resistor (3,4) R in ohms
C capacitor (5,6) Gin farad
L inductor (7,8) L in henry

Connectorl 3-terminal connector (9,10,11)
Connector2 3-terminal connector (12,13,14)

The interconnection architecture consists of the pairing of the terminals: {10, 1},
{11, 7}, {2, 5}, {8, 3}, {6, 13}, {4, 14}. The external terminals are {9, 12}. The
other terminals are internal terminals. This leads to the following equations for
the full behavior:

Modules Constitutive equations
R 11+120 V1—V2RcI1
RL 13+140 V3—V4=RLI3
C 15+160 C(V5-V6)=I5
L 17+180 V7V8LI7

Connectorl 19 + 110 + = 0 V9 = V10 = V11

Connector2 '12 + 1j3 + '14 = 0 V12 = V13 = V14

Interconnection pair Interconnection equations
{1O,1} V10=V1 110+11=0
{11,7} V11=V7 111+17=0
{2,5} V2=V5 12+15=0
{8,3} V8=V3 18+130
{6,13} V6=V13 16+113=0
{4, 14} V4 = V14 14 + I4 = 0

Now we have

full = {(V1, I, . . . , V14, I} the above equations are satisfied}.

Suppose that the variables corresponding to the external terminals 9 and 12 are
the manifest variables. Denote w = (i , I9 V12, '12) and
I = (V1, Ii,..., 8' '8, V10, 1i, i11, 1j V13 13 V14, 114). This yields

= {w E R4 there exists I E R24 such that (w, 1) E full}
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Example with an higher dimensional index set:

Figure 1.6: Elastic membrane

The interaction of this module with its environment takes place through the
whole module. So it has one terminal. Indicate by u(x, y, t) (u(x, y, t), u(x, y, t))
the displacement at time t ofa point at position (x, y) when the membrane is not
deformed. Denote by F the external force applied to the point of the membrane
in position (x, y) at time t. The system is regarded as a distributed mechanical
terminal with terminal variables (ui, u, F, F). The equation of motion is

a2pu = (\ + )V(V • u) + tV2u + F

with parameters p, the mass density, and constants .A and p (lamé constants), de-
scribing the elastic behavior of the membrane. This yields the behavior

= {(u,, ui,, F, F) : —÷ ]R4 above equations hold}.
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Chapter 2

Systems Theory and The Behavioral
Toolbox

In this chapter we introduce the essential mathematical concepts that are involved
with modeling systems as done in the previous chapter. We only concentrate on
systems whose trajectories can be described as solutions (most generally in the
sense of distributions) to a set of linear (partial) differential equations.

Definition 2.0.1 A dynamical system is a triple = (I, W, ) with W the signal
space, I the index set and C W11 the behavior of the system, i.e. the set of all
trajectories allowed by the system.

There are two crucial aspects concerning this definition. First of all, it aban-
dons the idea of a system as input/output map (signal processor) and all the quanti-
ties for which no hierarchical or cause/effect structure is a priori given. Secondly,
there is a clear distinction between the feasible trajectories and its representation
(equations, graphs, grammar rules, ...).
Classical notions such as linearity and shi fl-invariance are at this abstract level
already defined. A dynamical system is called linear if W is a vector space and B
is a linear subspace of W', and is called shift-invariant if II is a semigroup under
addition and at = for all t E 11, where o is the shift operator defined by
(atw)(x) = w(x + t).
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Example: Maxwell's equations describe the possible realizations of the fields

These equations are

V.E =

c2Vxfi =
EO Ot

with e the dielectric constant of the medium and c the speed of light in the
medium. They define a dynamical system = (R x R3, R3 x W x R3 x R, B)
with behaviors the set of all fields (E, p) : R x R3 —÷ R3 x R3 x R3 x R
that satisfy Maxwell's equations.

As seen in chapter 1, also systems with latent variables should be considered:

Definition 2.0.2 A dynamical system with latent variables is a quadruple >L =
(lE, W, L, Bfu1I), with lithe index set, W the manifest signal space, IL the latent
signal space and Bf11 C W' x Ii) the full behavior of the system

Note that if we write W = Wx L, then EL = (I, W, fu1I) is a dynamical system as
in definition 2.0.1. A dynamical system with latent variables induces a dynamical
system in the sense of definition 2.0.1 as follows:

Definition 2.0.3 Let EL = (I, W, L, fu1I) be a dynamical system with latent
variables. The manifest dynamical system induced by EL is the dynamical sys-
tem E = (lE, W, ), with behavior defined as:

= {w : I —* W there exist I E L such that (w, 1) E BfII}
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2.1 Differential systems

What we are really after in modeling a system, is its behavior , the set of admis-
sible trajectories. Although a behavior can be described in various ways, there is
one class of systems that plays a prominent role: the dy'ferential systems. A dif-
ferential system is defined, with II = R' and W = Ru, as a system whose behavior
B is described by all solutions of a finite set of partial differential equations of the
form:

f(x, w(x),. .
., (Ô)k) =0

Here we use the multi-index notation ()1c = O+ with k = (k1,. . . , k,).
1:1 •••3x1,

We also assume that only a finite number of such partial derivatives are involved.
This class of differential systems has an important subclass, the class of differen-
tial systems with constant coefficients. These are systems whose behavior consists
of all solutions of equations of the form:

a aR(—,...,—)w=0

where R E R"[1,. .
. ,] is a polynomial matrix in n indeterminates with w

columns and an arbitrary (finite) number of rows. For obvious reasons, 'B =
ker(R(—,.. ., i—)) is called a kernel representation with kernel R.
Of course, one has to specify what kind of solutions one is looking for. In the fol-
lowing, we are only concerned with smooth solutions or solutions in the sense
of distributions. The set of distributions with respect to a test-function space

Rm) is denoted by D'(R'2, Rm).

First we have to introduce some notation. A module X C R . . , }, gen-
erated by a finite number of elements x1, . . . , x, E I (a noetherian module), is
denoted asi =< x1,. . .,x, > orbyl =< X > withX = mat(xi,. ..,x) the
matrix which has x1,. . . , as its columns.

A fundamental question is: suppose we have two kernel representations, when
do they define the same behavior? This is answered in the following theorem:

Theorem2.1.1 LetR1, R2 E Then ker(R1(—,...,—)) =
ker(R2(—,. . ., < >=< Rf>

This theorem establishes the correspondence between behaviors and submod-
ules of RV [s,.

. . , ]. But this depends on the solution space under consideration:
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it holds for it°° or Y solutions. It also reflects the fact that a behavior admits
many representations. A consequence of the theorem is, since we can transform
a polynomial matrix in one indeterminate in a matrix of full row rank and that
according to the theorem the corresponding behavior will not change, that we can
always find a full row rank kernel representation for a kernel behavior involv-
ing one indeterminate. This result was also derived in [5J. This is a so called
minimal representation. For systems involving more than one indeterminate, it is
more complicated. Example: suppose we have a behavior defined by fwi = 0,

= 0 with manifest variables w1, w2. Obviously, the corresponding kernel
matrix doesn't have independent rows. But we can not replace these two equa-
tions by a single one and still maintain a kernel behavior. This example shows
that things work really different for ND-systems.

In the Behavioral Toolbox:

A minimal kernel representation is calculated, with the use of the rn-file of The
Polynomial Toolbox prowred.m. So the result is in fact stronger: it is row proper
or row reduced. This means for a polynomial matrix R that the matrix Rho, which
consists of the coefficients of the entries of R corresponding to the highest degree
of each row, has full row rank. The rn-file interfacing Matlab and BTB (short for
Behavioral Toolbox) is iprowred.m.

2.2 The elimination problem

Suppose the behavior of a system, with manifest variables w and latent variables
1, admits a kernel representation with kernel matrix R E IR.x(w+l)[ei . .

, ]. In
this case we have:

full = {(w, 1): R' —÷ W x L R(-,. . ., i-.) [] = 0}

= {w : R' —+ W I there exists I L such that (w, I) E BflI}
A natural question arises: is there also a differential representation of the behavior
which does not involve any latent variables? As we will see, such a representation
exists.

Definition 2.2.1 Let T E RPXS[e1,.. .
, J. The set of Sygygies of T is the set

SYZ(T)= {h E
I
Th = 0}
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It is easily seen that SYZ(T)c R'[1,. . ,E] is a module over R[1,.. . ,E].
Therefore, it is also referred to as Sygygy module of T. Since RS [fl,..

. , ] is
a noetherian module and SYZ(T)c W[i,. . . , ], there exist a polynomial ma-
trix H such that < H >=SYG(T). Now we state the following result:

Theorem 2.2.2 Let B be the manifest behavior corresponding to the latent vari-
able representation N(, ..., = !tI(&,. . . , &-)l. Then the following
are equivalent:

(i) w E

(ii) h E SYG(MT) .., ., = 0

This result depends again on the solution space choosen! The theorem holds for
°° or distributions but, for example, not for solutions that are
A consequence of this theorem and the the fact that a Sygygy module is noetherian
is the following corollary:

Corollary 2.2.3 (Elimination theorem) Let B be the man (fest behavior corre-
sponding to the latent variable representation N(,.. . , =
M ( i—,. . ., i— ) 1. Then there exists a polynomial matrix H such that

T0 ô 0= ker(H (—,.. . , —)N(—,..., —))Ox1 Oxn Ox1 0x
This corollary is referred to as the elimination theorem. In order to compute a
kernel representation of the manifest behavior, we have to find a set of generators
of the Sygygy module of MT. For systems with a one dimensional index set,
in Matlab's Polynomial Toolbox there is an implementation for finding a set of
generators.

in the Behavioral Toolbox:

The Polynomial Toolbox command xab is used. This command solves the poly-
nomial matrix equation XA = B. If B is a zero matrix of any size, it computes
a basis for the left nulispace of A. BTB uses the rn-file ieliminate.m, interfacing
BTB and Matlab

14



2.3 Observability and Controllability

Two central concepts in systems theory are the notions of observability and con-
trollability. Classically, for state space systems (see section 2.4.2), observability is
defined as the possibility of deducing the state from an observed output. Control-
lability is defined as the possibility of transferring the state from any initial state
to any final state value. In behavioral systems theory however, see [5],[1J and
references therein, these notions are extended to more general model classes of
systems and do not depend a priori on a input/state/output structure being given.

2.3.1 Observability

In behavioral systems theory, observability means the possibility of deducing
some variables while observing the other ones. However, we restrict attention
to observability of latent variables:

Definition 2.3.1 Let = (I, W, L, !fu11) be a dynamical system with latent vari-
ables. The latent variable I is observable from w if

(w, I) E fu1I and (w, 1') E fu11 I = 1

If the full behavior is linear, then this definition is equivalent to the condition

(0, 1) E fu1I I = 0

For a hybrid representation N(-,.. . , —)w = M(-,. . . , —)l, asking for
observability is thus equivalent with asking for M(—,. . . , i—) to be an injective
map.

Theorem 2.3.2 Let fu1I be the linear differential behavior given by

fut1 {(w, 1) E N(—,. . ., = M(—,.. ., _)I holds}

with M E R'[1,. . . Then the following are equivalent:

1. 1 is observable from w

2. <MT > = R'
. ,

3. rank(M(.Ai,...,)))=lforall)C

Condition 2 of the above theorem gives us the possibility of verifying observabil-
ity.
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In the Behavioral Toolbox:

In [1], an algorithm for checking observability is deduced (algorithm 90). Short
description of the algorithm: the idea is to extract rows from M of degree zero by
looking at the matrix Mh, which consists of the coefficients of entries (polyno-
mials) of M corresponding to the highest degree of every row. If the rows of Mh
are not independent, select the corresponding row of highest degree of the rows of
M and replace it by the previously found linear combination of these rows. This
degree reduction corresponds to multiplying with a unimodular matrix and hence
the behavior does not change, see [5] and theorem 2.1.1. If the rows of degree
zero span R' then condition 2 of theorem 2.3.2 holds. For a detailed description
of the algorithm, the reader is referred to [1].
BTB uses the rn-file iobservabilizy.m as the interfacing file with Matlab. This file
primarily uses the rn-file observabilizy.m

2.3.2 Controllability

We introduce a definition, see [5] and [1], of controllability which only relies
on the system's trajectories, and not on specific properties of special variables
chosen to represent it. This in contrast to the classical definition of controllability
involving state variables.

Denote by U the closure of a set U.

Definition 2.3.3 A behavior ¶ with 11 = R'2 is controllable iffor all w1, w2 B
and open subsets U1, U2 C R' with U1 fl U2= 0, there exists w E such that
w = w1 on U1 andw = w2 on U2.

So a behavior is controllable if solutions are patchable.
In particular, if the index set I is equal to R, one can easily show that the above
condition is equivalent with the following: for all w1, w2 E and t1, t2 E R,
t1 < t2, there exists w E B such that

t—' wi(t) t�ti
t�t2
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Figure 2.1: N-D controllability

Figure 2.2: 1-D controllability

In the general case that II = R, the following theorem relates the controllability
of = ker(R(-.,. . .

, i—)) with properties of the syzygy module of R:

Theorem 2.3.4 Let R E R X U [,•• , ] and M E RV X•
[ ] be such

that SYZ( R) = < M >. Moreover let R1 E XV [• . , ] be such that
SYZ(MT) =< Ri>. Then

= ker(R(—,.. ., is controllable < RT >=< RT>

In the special case that n = 1, there holds:

17
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Theorem 2.3.5 Given R E R[]. The following are equivalent:

1. B = ker(R(j)) is controllable

2. rank(R\)) is the same for all A E C

3. If N is any polynomial matrix whose columns form a minimal generating
set for the module < R" >, then N E I.XC[} and rank(N(A)) = cfor any
A e C where c = rank(R)

Theorem 2.3.6 Let R E [] be a full row rank polynomial matrix. The fol-
lowing are equivalent:

1. B ker(R()) is controllable

2. The columns of R span the whole module R []

3. rank(R(A)) = pfor all A E C

Comparing this theorem and theorem 2.3.2, ones sees that the conditions for
controllability are dual to the condition for observability only in case R is of full
row rank. Obviously, you cannot observe "too many" variables (M does not have
full column rank, excluded in theorem 2.3.2), whereas "too many" equations (R
does not have full row rank, excluded in theorem 2.3.6) may still define a control-
lable behavior.

In the Behavioral Toolbox:

This duality implies that we can use the observability algorithm in case R is of
full row rank. In general, observability of RT checks condition 2 of theorem 2.3.6
and outputs a degree reduced matrix R whose columns generate the same module
as the original R. If true comes out, then we are done. If not, then, as already dis-
cussed, the behavior could still be controllable. The algorithm extracts constant
columns of R until they span the proper space or until no more degree lower-
ing is possible. In the last case the columns of nonzero degree are indepent of the
other columns. In general, one cannot expect that these obtained constant columns
are independent. If they indeed are not independent, replace these columns with
columns that are independent and that span the same space. The rn-file reduce.m
does the computation. Since the columns of degree more then zero are already in-
dependent of the other columns, the number of columns of the transformed matrix
R is equal to its rank. In case the rank equals the row dimension of R, then by
theorem 2.3.6, the test performed by the observability algorithm is necessary and
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sufficient for controllability. Otherwise, we apply condition 3 of theorem 2.3.5 to
check controllability; use the observability algorithm again with the transformed
R as input. B1'B uses the rn-file con:rollabilizy.m and interface file icontrollabil-
ity.m.

2.4 Inputs, Outputs and States

Classically, most models of a physical system are given in inputfoutput form or
input/state/output form. However, these description are not a veiy natural thing
to stan with. First of all, models from physics do not occur in either one of these
forms. Secondly, interconnected systems are not described by input/output pair-
ing.

Of course these concepts are very useful, for instance for simulation. But these
structures are too restrictive as a starting point in a more general framework. In-
put/output representations or input/state/output representation show up naturally
a posteriori instead of a priori.

2.4.1 Inputs and Outputs

Equations that usually appear in textbooks are of the form:

Q()u = P()y
with P and Q polynomial matrices such that P'Q, the transfer matrix of the
system, is a matrix of proper rational functions i.e. the degree of Q is at most the
degree of P. In this case, u is called the input, yielding an output y. We begin
with the concept of free variables of a differential system:

Definition 2.4.1 Let = (I, W, ) be a differential system. Variables u are said
to be free if there exists a permutation matrix H such that for all u E 00(Rtz, RU)
there exist a y E t°°(R', RY) yielding w = fl(u, y) E . Variables u are called
maximally free in if y does not contain any further free components.

This definition also holds for distributions.

Lemma 2.4.2 Let B ker([Q(—,.. .
, i—) — P(-,.. ., i—)]). Let w =

(u, y) be partitioned according to the Q and P matrix. Then u is free if and only
if

SYZ(PT) = SYZ([Q — p]T)

19



However, which variables among the variables actually can be regarded as max-
imally free is not unique. In fact, many possible subsets of the w's can play this
role. What is unique is the number of maximally free variables. The following
theorem tells us what this number is.

Theorem 2.4.3 Let R R• [, . . . , ]. The cardinalizy of a set of maximally
free variables in = ker(R(, . . ., i—)) equals w — rank(R)

This can be interpreted as follows: the number of maximally free variables
equals the number of variables (w) minus the number of independent constrains
imposed (rank(R)). The following definition leads to inputs and outputs in the
classical sense:

Definition 2.4.4 Variables u are said to be smoothly free in ffor all u E
k(Rn,Ru) there exist y E k(Rn,RY) such that w = H(u,y) E B with H a
permutation matrix. They are maximally smoothly free f y contains no further
smoothly free components.

Now the theorem that establishes the link with the classical concept of inputs:

Theorem 2.4.5 Let S = ker(R()) be described by

= P()y
with w = (u, )T and R = [Q — P] of full row rank. Then u is maximally
smoothly free if and only if P is a nonsingular submatrix such that P—'Q is a
matrix of proper rational functions.

In the Behavioral Toolbox:

Theorem 2.4.5 is used. Firsts R is row reduced using the rn-file prowred.m of
The Polynomial Toolbox, where after the matrix is sorted by descending column
degree. Then the matrix Rh is formed which consists of the coeffients of R
corresponding to the columns of highest degree of R. Subsequently, a minor of
Rh is obtained with the use of the rn-file minor.m which start looking at the first
columns. Now stack the corresponding columns of R, defining a matrix P, and
stack the remaining columns of R, defining a matrix Q. This guarantees that
P—'Q is a matrix consisting of proper rational functions. The rn-file that BTB
uses is io.m with interface file iio.m

20



2.4.2 State Representations

Define the concatenation at t0, A<,, as

1A f f(t)fort<to
J to_g(t)f0t>t

We begin by giving an abstract definition of state:

Definition 2.4.6 Let L = (R, W, X, !BfIl) be a dynamical system with latent
variables x E X and manifest variables w E W. L is called a state system if
(wi, x1), (w2, x2) E fu11 and xi(to) = x2(to) imply (w1, x1) At0 (w2, x2) e fu1I
The variable x is then called the state.

This definition captures the intuition of state variables as being the memory of the
system. It summarizes all the information of the past of the system which we need
to know in order to establish its future behavior.

Theorem 2.4.7 An ordinary dyj'erential system N(g)w = M()x with latent
variables x and mantfest variables w is a state system f and only f there exists
real matrices E, F, H such that the behavior fu11 is represented by

4x+Fx+Hw=O (2.1)

Note that equations 2.1 are of first order in x and of order zero in w.

Definition 2.4.8 Let = ker(R()). A polynomial matrix X is said to be a
state map for B f the latent variable system

R()w=O

X(-)w=x
is a state system

The following result shows that every kernel representation admits a state map.
First we define the shift-and-cut operator a: [] jpxq [] as

PO+P1e+.+PL4pl+p2+...+pL'
Theorem 2.4.9 Let R e RPXW [] with deg(R) = L. Then the polynomial matrix

a(R)

aL(R)

induces a state map for = ker(R()).
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Of course we can use the results from section 2.4.1, in order to obtain the follow-
ing:

Theorem 2.4.10 Let 23 = ker(R(g)). Then there exists real matrices A, B, C, D
and a permutation matrix H such that H(u, )T e 23,

d
= Ax + Bu

y=Cx+Du (2.2)

defines a state system and variables u are smoothly free. Equations (2.2) are
called an input/state/output representation for 23.

However, a state representation is not unique. In fact, see [3], for a kernel
behavior 23 with kernel matrix R, all polynomial matrices X such that ER =
AX + BR for a real matrix A and a polynomial matrix B, induces a state map
for 23. What is unique, is the smallest number of state variables associated to 23.
This number, called dynamic order or McMillan degree of 23, is denoted by n(23).
State maps with exactly n(23) rows are called minimal state maps. In fact:

Proposition 2.4.11 Let 23 = ker(R()) with R row reduced. Then the polyno-
mial matrix X that consists of the nonzero rows of ER induces a minimal state
map for 23.

In the Behavioral Toolbox:

A minimal inputistate/output representation is computed, using proposition 2.4.11.
First, R is row reduced and a state map X is constructed from ER. Now theorem
2.4.10 implies that:

FR 0 1 Il -D -C 1

LX —I] Lo —B
(2.3)

for real matrices A, B, C and D, where R1 R2 means that there exists a uni-
modular matrix U such that R1 = UR2. This property is exploited in the rn-file
iso.m with interface file iiso.m.
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2.5 Simulation

Obviously, one wants to compute trajectories of the behavior of the dynamical
system being modeled. In this section we will discuss behaviors of the form

fuI1 = {(w,f) e Y(R,R)
I

= M()f} (2.4)

We think of f as a vector-valued distribution called forcing functions or external
functions, while w is a trajectory to be computed. Together with (2.4), we also
consider initial conditions

(S(-)w)(to) = a (2.5)

where S is a polynomial matrix and a a real vector.

Definition 2.5.1 Let fu11 = {(w,f) E D'(R,R) I M()f}. Be-
havior fuII is solvable for a given f E '(R, R) f there exists a w E Y(R, RV)
such that (w, 1) E Bfull. If this holds for any f E D'(R, Rt), then Bfll is solv-
able.

This definition can be recast in the language of latent variable representations.
Consider Zuii as a full behavior with latent variables w and manifest variables
f, and is the manifest behavior. Then solvability for a given f simply means
f B, while fu1I is solvable is equivalent to = D'(1R, Rt). This directly
(theorem 2.2.2) leads to

Corollary 2.5.2 fujI as defined in (2.4) is solvable for a given f E D'(R, R) f
and only if

n E SYZ(GT) 7.T((1 )M(1 )f =
fu11 is solvable if and only if

n E SYZ(GT) flTM =0

In the Behavioral Toolbox:

From the above corollary it follows that if G of full row rank, then solvability is
assured for any f. It also leads to the following:

[G M] [' ,,J
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with G' of full row rank. Now BfulJ is solvable for given f if M,()f = 0 and
solvable if M3 = 0. If we write M8 = M0 + + M3d5' then M3()f = 0
[M30 Md][f f(d)]T = 0. These derivatives are calculated within BTB
and are send to the Matlab working space. Caution, if the step size for the sampled
time is not small enough, it can lead to a false answer!!!

Now suppose that fu1I is solvable for a given f. How smooth is a trajectory
w such that (w, f) E fu1I? This relationship leads to the index of a behavior.

Definition 2.5.3 Let BfuII be defined as in 2.4. Define

3 = {(ji,.. .,j) I
forallfwithf, e k+j1 there existsw E
such that (w, f) E fu1I}

where tk for k < 0 is defined as the set of all distributions whose 1k I-th prim-
itive is a continuous function. Let be the partial ordering (ai, . . . , c)
(/3k,. . . , /3) c, </3, i = 1,. . . , f. Define the multi-index 1a as the smallest el-
ement of3 with respect to such a partial ordering, and the index ii = max{p2 I i =
1,...,f}.

The multi-index establishes the minimal differentiability requirement on each
component of f which assures that a sufficient differentiable trajectory w can be
found. Indeed, this multi-index is well defined:

Theorem 2.5.4 Let fu1I be defined as in (2.4) with G E RPXV [] of full row rank.
Let P be a square submatrix of G of maximal determinantal degree. Let ö, be the
difference between the degree of the numerator and the denominator of (P' M),,.
Then the multi-index is given by (.t',.. . , jt) with = maxc5,.

In the Behavioral Toolbox:

Theorem 2.5.4 is implemented in the rn-file index.m which calculates the index of
a behavior of the form (2.4). The interface file is iindex.m.

How to check if there is a solution w of the behavior of the form (2.4), solvable
for a given f, that satisfies (S()w)(to) = a?
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In the Behavioral Toolbox:

Since we already have checked the solvability condition, we now have a represen-
tation = M()f with G of full row rank. Assume also that G is square
so that det(G) 0, since there will be no unique solution if G is not square. We
can write M = GQ + R with R such that R = 0 or G'R is strictly proper. This
is done with the use of the m-file pdiv.m. In case G is of degree zero, R = 0 and
the initial conditions (Sw)(to) = a yields (SQI)(t0) = a. A degenerated state
space representation i.e. without state variables is constructed and simulated with
the command isim.
Now consider the case that G is not of degree zero. Since

Gw_-Mf GQ9)=Rf
= GQf+Rf :=e

and G'R proper, we have a state system

= Ax + Bf (2.6)

e=Cx+Df (2.7)

This last equation is equivalent to w = Cx + (Q + D)f. Therefore,

(Sw)(to) = a (SCx)(to) + (S(Q + D)f)(t0) = a.

Denote S(Q + D) = L. We can rewrite SCx with the use of (2.6). Suppose
S() = S0 + S1 + + S5E and L = L0 + ... + L1' . If s = 0 then
Sw = S0x + [L0 .. ... f(1)]T,

. Otherwise, since

(-)"x = A'1x + A''Bf + ... + ABf2) + Bf'
it follows that

SCwIteo = S0Cx + + S5C(-)xIt + LfIjto
[S SS][C CA CA3]TxItt0 +

C 0 •••0 B
CA C ...Ø I

[S1•..S3] . . Bf'CA'' CA2 ... C t=to

+ [L0 L1J[f .
f(1)]T1

= a

25



Rewrite this to an equation of the type Px0 = b where x0 = x(to). Write P =
UXV, the SVD-decomposition of P. yielding

Px0 = b U'Px0 = U'b

After removing the last zero equations, we have obtained an equation for x0:

Pxo=b

with p of full row rank. If rank([p b]) > rank(p), no solution exists i.e. the
....T

initial conditions are not well-posed. Otherwise we take x0 =P (PP )' b. If
Q = Qo + + Qq, then we have a state system

-x=Ax+[BO.•• O]df

w=Cx+[Qo ... Qq]df

where df = [f f(l) ... f(q)]T With the use of matlab's command isim, a so-
lution w of this state space representation is computed with x(to) = x0 as initial
condition.
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2.6 Things for future releases of BTB

Of course there is much more developed in behavioral systems theoiy. Further
more, due to time limitation, there are a number of things that should be supple-
mented or extended.

• A state map for the manifest behavior is calculated by first calculating the
kernel representation of the manifest behavior by elimination. It is also
possible to calculate this state map with the use of the hybrid representation.

• A linear time-invariant differential system is controllable if and only if it
admits an image representation. Computing image representations would
be a valuable extension of the program.

• For nonlinear systems, we wish to compute the stationary points and lin-
earize the system in one of these points.

• The more general theory for ND-kernel behaviors should be implemented as
well. This requires the use of Grobner bases, see [1] for more information.

• Implement stabilizability of a kernel behavior and detectability of a full ker-
nel behavior. For more information about these topics, the reader is referred
to[5].

• As discussed in section 2.4.1, an input/output partition of a behavior is not
unique. The program picks just one of them and this partition may not be
the partition one is looking for.

• A state map for the behavior can be computed. But this state map can not
be used for the initial conditions in the simulation automatically.

• Equations has to be typed in with the characters # for variables and @ for
parameters. This is not very desirable.

• In the simulation window, it would be convenient if the user can see the
impuls response, etc at an earlier stage.

• Eventually, the program should be autonomous i.e. does not need Matlab
for its computations.

• A consequence of the limitation of the language JAVA, where BTB is writ-
ten in, and the time limitation is that the user interface visualizes the model
of an interconnected not very clear. Particularly, the use of a scratch of pa-
per and pencil to assist the user is almost inevitable. A way to omit this
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adventitious circumstance is, for instance, the use of icons for the modules
and connect them by drag and drop principles.
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Chapter 3

Documentation

How to use the Behavioral Toolbox?

3.1 System Requirements

In order to be able to run BTB (short for Behavioral Toolbox), you must have:

• OS: Win95I98IMEINT4INT5/2000 or some Unix based system such as Linux

• Matlab version at least 5 should be installed with a license of the control
toolbox

• Java version 1.3 is also required. It can be obtained for free at: http://java.sun.com

Remark: If you have no license for the control toolbox, the only thing that
doesn't work in BTB is displaying trajectories in a figure.

3.2 Installation and getting started

To install the program on the system (be sure that you have write permission),
type in the following (or something similar):

java -jar install.jar

Follow the instructions on the screen. Every user with read acces to the speci-
fied program location can now setup BTB as follows:

java -jar BTB.jar
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and fill in the blanc fields. Your settings will be stored in a file ".BTB.ini" on
the root of your account. Now you are able to run BTB:

java -jar BTB.jar

3.3 What is BTB

There are many simulation programs in use, but almost all based on regarding sys-
tems as signal processors, or using Bond-graph methodology (for instance Mat-
lab's Simulink, Spice, Modelica and MT1'). Our goal was to create a simulation
tool based on "The behavioral approach" (e.g. see [1] and [3]) for more details)
and modeling interconnected systems with the terminal approach (see chapter 1).
Our main interest are linear systems, this doesn't mean that nonlinear systems
cannot be considered, but the possibilities are more limited.

The program is written in the language JAVA. The main reason is that JAVA is
an 00 language (see appendix A. 1). For heavy calculations we use Matlab. The
desktop of Matlab will not appear so the user isn't aware of its use.

In the next figure an example is given of the main window of BTB, which
contains a model of an electrical system modeled in the Behavioral Toolbox. How
to model such a system is explained in section 3.4.
In figure 3.1, you see information of the system being modeled:

Name The name of the inserted module, provided by the user
Type Type of the inserted module, i.e. Resistor, Capacitor,

Spring, Vessel
Free terminals The terminals of the module which are not connected
Connected terminals The terminals of the module which are connected with

other terminals
Connection architecture The connection architecture of the whole system;

in the picture you can see that terminal 1 is connected
with terminal 4 and terminal 2 with 6

Also some properties of the system are shown in a TextPane below the lists. This
is discussed in section 3.6.4.
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3.4 Modeling a system

To model a dynamical system, you insert the modules and connect the terminals
of those modules. We already implemented a number of standard modules, but it
is also possible to model a system with a new module kind of module. For that,
you have to create a new module class. This should be done with the following
steps:

1. Create a new type of terminal (if necessary).

2. Create a connection for that type of terminal (if necessary).

3. Create a new module class.

A logical way to model a system with the BTB is to

1. Insert modules in your system.
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2. Connect terminals.

Conversely, you can also undo these actions:

1. Disconnect terminals.

2. Remove modules from your system.

How to do this is explained in the next seven subsections.
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3.4.1 Create a new type of terminal

To create a new type of terminal, select in the menubar in the main window Ter-
minal> Create new type of terminal.

Figure 3.2: Create a terminal

Specify the type of the tenninal, which amounts to associating the set of corre-
sponding variables with this terminal. In the second textfield, the variables has to
be typed in. When ready, press "OK" to create this new type of terminal.

3.4.2 Create a connection

As discussed in chapter 1, connecting terminals imposes some additional restric-
tions called interconnection constrains. In the program, a connection carries these
restrictions. In order to connect a new type of terminal, a new type of connec-
tion has to be created first. Select Connection > Create new connection in the
menubar in the main window.
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Figure 3.3: Create a connection

Select a type for this connection in the choiselist. The connection constrains has
to be in terms of the variables that are given. If you don't use these variables,
errors occur later on. For an equation we use the following convention:

1. Write the equation in the form f(x) = 0.

2. Put before each variable a # character.

E.g. #wl + #w2 = 0. Here wi and w2 are the variables on the terminals.

Press the "OK" button to create the connection.

3.4.3 Create a module class

To create a new module class, select Module> Create new module in the main
window.
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Figure 3.4: Create a module

Now do the following steps:

1. Provide the class name of the module. This is the name that you will hence-
forth use for this module class. For example, you could use 'Resistor' for
an electrical resistor or 'Spring' for a mechanical spring.

2. Provide the type of the module. The type is identified with the name for
the family of classes, where this module class belongs to. For example, a
resistor belongs to the family of electrical modules.

3. Add a number of terminals to the module. (If the terminal is not available,
create it first (section 3.4.1)
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4. Provide the constitutive equations of the module in terms of the variables
that are given. If you don't use these variables, errors occur later on. We
use the following convention for an equation:

(a) Write the equations in the form f(x) = 0.

(b) Put # before the variables and @ before the parameters, which are the
physical constants of the module.

(c) For derivatives use the D-operator. Where

D(i1,...,i)f(x1,...,x) =

For example, the equation for a vessel is given by @S * D(1)#Ht—#f = 0.
Here H is the variable which denotes the height in the tank, f is the variable
which denotes the flow and the parameter St is the surface of the tank.

5. Press the "Add equation" button to add the equation to the module.

6. Repeat step 4 and 5 for all the equations.

7. Press the linear checkbox if the equations of the module are linear.

8. Press the "OK" button to create the module.
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3.4.4 Insert a module in the system

To insert a module into the system, select Module > Insert module. If the module
is not available, created it first (section 3.4.3).

1Sgt1: m.àk.th. ...

A .qg....

....t.b.
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th.

All ,
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Figure 3.5: Insert a module

Select the type and the class name of the module you want to insert. A suggestion
for a name of this module - only in this session - is already given, but you are free
to change it. Also the symbolic parameter can be changed as well, so there will
be no parameters with the same identifier in the current session. Press the "OK"
button to insert this module.
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3.4.5 Connect two terminals

Terminals that are not already connected (free terminals) can be connected, but
only if they are of adapted type (see chapter 1). Not all terminals have to be
involved in the interconnections. Those terminals which are not involved are the
so called external terminals. The terminals entered in the connection architecture
have the role of internal terminals (see again chapter 1). To connect terminals,
select Terminal> Connect in the main window.

Select a terminal in the left list. Doing so, only the free terminals of the adapted
type as the selected terminal remains in the right list. Now select a terminal in the
right list and press the "connect" button. Repeat this action for all the connections
you want to make. To close the window press the "quit" button. When a connec-
tion is made, the variables on the connected terminals will be assigned latent. To
change this assignment, see 3.6.2.

3.4.6 Disconnect two terminals

Terminals can be connected, but also the reversal of this is possible. Select the
connected pair in the list showing the connection architecture. Select Terminal>
Disconnect two terminals and the terminals will be disconnected. Another way
to do this is, is to select the connected pair, press the right mouse button and select
Disconnect.

S.1.t .
U c.ct tna S.

Th. .th.td
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S. i.I.ct.4.

Figure 3.6: Connect terminals
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3.4.7 Remove a module from your system

A module can be removed from the system. If you want to do this, select the name
of the to be removed module. Press your right mouse button and select Remove
from session. Another way to do this: select Module> Remove from session.

I
— lu_a

R.iv..fr__ lu

Figure 3.7: Remove a module

Select the name of the to be removed module in the list and press "Remove". The
module will be removed (of course all its connected terminals are disconnected
and removed as well).

3.5 Information and corrections

In the previous section we discussed how to model an interconnected system and
how to change it by (dis)connecting terminals and removing modules. But a mis-
take is easily made. For example when creating modules and connections. But
how do we find out that we made mistakes?

In this section we explain how to find out what the mistakes are and how to undo
this mistakes. We consider the next four items:

1. Show information of the modules.

2. Show information of the connection constrains.

3. Change a module class.

4. Change a connection.
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3.5.1 Information of the module

If you want to see information of a certain module, select the name of the module,
press the right mouse button and select Info.

—Al the aetl.nmes
.%me the
e—'t.t.

Figure 3.8: Information about the module

Here you see information of the class name, type, linearity, and the equations of
the module. But also information of the variables and connections of this module
is provided.

3.5.2 Information of the connection constraints

For information of the connection constrains, select the connection in the list with
the connection architecture, press the right button of your mouse and select Con-
nection constraints.
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Figure 3.9: The connection constraints

3.5.3 Change a module

If you have found out that you made a mistake, when creating a module, you
obvious want to change this module. Select Module > Change module. To find
out what the mistake could be, read section 3.5.1.

Figure 3.10: Change module

42



After selecting the module - the one you would change - in the choice box, all
the attributes (like type, linearity and equations) of the selected module are shown
and you are able to change them. Note that you have to provide the equations as
in 3.4.3! When ready press the "OK" button.

3.5.4 Change a connection

If a connection is not correct, you want to change it. Select Connection> Change
connection.

Subsequently, after selecting the type of the connection you want to change, you
can edit the equations of the connection. For notation see 3.4.2.

Ale. ...u.., .f
thai c.a..

Al ...èk c—

Figure 3.11: Change connection
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3.6 Behavior

A typical user is interested in the behavior of the modeled system (equations, ker-
nel representation, input/output representation, etc.). To compute these represen-
tations, the program uses Matlab (see chapter 2 for more details). A consequence
is that parameters must have numerical values before computing these representa-
tions.

If you are interested in some variables in particular, which might be on a con-
nected terminal and thus assigned latent as a default, you have to assign them
manifest.

In this section we explain how to:

1. Change the values of the parameters.

2. Do manifest/latent assignment of the variables on the terminals.

3. Show the (full) behavior (equations, kernel, 10, ISO).

4. Show the properties of the system.

3.6.1 Change the values of the parameters

Before computing some of the representations, parameters need to have numerical
values. If you want to see a representation and the parameters or still symbolic you
will be alerted to change them. To change the values, select Module > Change
parameters.
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Figure 3.12: Change parameters

Select the name of the module with the symbolic parameters. Select the parameter
and change the value in the textfield. In the right list the value of this parameters
is shown. Repeat this for all parameters and press "OK". At another time you are
able to give this parameter another (symbolic) value in the same way.
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3.6.2 Manifest I Latent assignment of the variables on the ter-
minals

When connections between terminals are made, the variables on these terminals
are assigned latent. When we now look at the representations of the external
behavior, these variables are eliminated. But maybe one is interested in variables
on internal terminals and wants to look at their behavior. A way to do this is to
assign these variables to be manifest. Select Terminal > Man/Lat assigmnent.
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Figure 3.13: Manifest / Latent assignment

Select the terminal with the variables you are interested in. Select the variable in
the right list (these are the latent ones) and push the>> button to to assign this
variable manifest. To assign variables latent select them in the right list and press
the << button.
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3.6.3 Show Behavior of the system

To show the desired representation, select Behavior and the representation you
want to see:

All equations. These equations are all the equations of the modules and the con-
nection constrains.
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Kernel representation.
This is the kernel representation R()w + M(g)1 = 0 of the behavior with w the
manifest and 1 the latent variables. Where

D.c.. . . ..dIia-I

d

Th. - .

N..

Figure 3.15: Kernel representation

At the left you find the Rj's and at the right the M1's. Also information about the
size and the order (order = i) is given. When a coefficient matrix becomes to large
it is shown in sparse matrix form i.e. the positions of nonzero matrix entries are
given together with the entry itself.

Minimal kernel representation.
This is the same window as above, but now with a row reduced kernel.
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Eliminated kernel representation.
The kernel representation R()w = 0 of the external behavior with w the mani-
fest variables. How to read this window we refer to kernel representation.

Figure 3.16: Kernel of eliminated system

Eliminated equations.
These are the equations of the external behavior.
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10 representation.
An inputioutput representation P()y = Q()u of the full behavior.

lire uvrçwlt / output ç.artjt,rur ft tire sysleni

Figure 3.18: 110 representation
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External 10 representation.
An inputloutput representation P()y = of the external behavior.
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ISO representation.
An Input / State I Output representation

gx=Ax+Bu
y= Cx+Du
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Figure 3.20: IJS/O representation

Press the 'OK' button for the state map:
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The window for an external ISO representation is the same as for the ISO rep-
resentation. Only the state map is different:

Figure 3.22: State map for external behavior
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3.6.4 Properties of the system

For controllability and observability of the behavior go to Behavior> Properties
> Controllability or Behavior> Properties> Observability. After you se-
lected one of the options the information is show in the main window, see section
3.2.

3.7 Re-Usability

A couple of modules of the interconnected system can be regarded as a module
itself. Suppose you have selected the appropriate modules. The terminals of this
new module are those terminals of the selected modules, that are not connected
with terminals of a selected module. The equations for this module are the equa-
tions of the external behavior, where the variables on its terminals are considered
as manifest. Select File> Re-Usability

Figure 3.23: Re-usability

Provide a new class name and a type for this module. Select the modules from the
current session, which will be the building blocks for the new module, and press
''I(''.
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3.8 Simulation of the external behavior

If you want to simulate the external behavior R()w — 0, select Simulation>
Simulate
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Specify forcing equations (these are additional equations, see also chapter 2)

= M()f
Use notation as in 3.4.3 and press "Calculate Index". Subsequently, after the index
is calculated, provide the forcing functions f. We consider 2 cases:

• f is an symbolic function: Provide the time interval and the function f to-
gether with degree of smoothness of f. If the degree of smoothness is equal
to infinity you don't have to specify it, or type 'Inf' in the textlield.

• f is numerical data: Provide the name of the rn-file with the data of f.

You can use the following functions, and combinations of them, for the forcing
functions:

polynomials, sin, cos, tan, sec, csc, cot, asin, acos, alan, asec, acsc, acot, sinh,
cosh, tanh, sech, csch, coth, asinh, acosh, atanh, asech, acsch, acoth, neg, abs,
sqrt, log, in, exp, . Provide these functions in terms of x.

Construct the m-file for the numerical data as follows:

function y =
y = [data of fi ; ; data of In];

Of course, the sample rate of f has to correspond to the sample rate of the time.
Save this file with the name f.m

After giving the forcing functions f, ..., In press "Check solvability". If the sys-
tem is solvable for these forcing functions, provide the initial conditions

S()w(O) = a

as equations (notation as in 3.4.3) in terms of the w variables and press "Check
well-Posed". If the initial conditions are well-posed press "Simulate".
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The following window appears:

Select the variables and press "Plot". Matlab returns a window with a plot of the
trajectory of the selected variables.

Figure 3.26: Plot of a trajectory

In this window, properties can be edited and the figure can be saved in numerous
formats.
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Press "LTI View" for step response, impuls response, Bode, Nyquist plot, etc...
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Chapter 4

The program

There are many simulation programs in use, but almost all based regarding sys-
tems as signal processors, or using Bond-graph methodology (for instance Mat-
lab's Simulink, Spice, Modelica and MTT). Our goal was to create a simulation
tool based on "The behavioral approach" (e.g. see [1] and [3]) for more details)
and modeling interconnected systems with the terminal approach (see chapter 1).
Our main interest are linear systems, this doesn't mean that nonlinear systems
cannot be considered, but the possibilities are more limited.

The program is written in the language JAVA. The main reason is that JAVA is
an 00 language (see appendix A.!). For heavy calculations we use Matlab 6.
The desktop of Matlab will not appear so the user isn't aware of its use.

4.1 Program analysis.

4.1.1 Specification of the program.

Since the program is responsible for constructing an interconnected system, rep-
resenting the behavior and simulating the system, it should be able to perform the
following tasks:

Construct an interconnected system. First of all, the program must deal with
creating terminals, modules and connections. When done, modules must be in-
serted in the current session and connections between terminals must be made,
but also the possibility to remove a module and to disconnect terminals has to be
available.

Represent the behavior. When constructed a system, the following representa-
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tions for the system should be available: equations, (minimal) kernel, eliminated
kernel, (external) 1/0 and (external) IJS/O. Also the properties like controllability
and observability should be implemented.

Simulate the system. After providing some forcing equations and initial con-
ditions, solvability and well-posedness need to be checked. When solvable and
well-posed, Bode-plot, Nyquist-plot, step response etc. must be available.

4.1.2 Description of the structure.

For a description of the attributes and methods see Help> Class description in
the program.
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4.2 Program design.

In the previous section we saw the structure and the specifications of the program
together with the description of the methods and attributes of the classes. In this
section we explain in what way the program works, using collaborations diagrams
(see Appendix A).

4.2.1 Building an interconnected system.

Create a new type of terminal: As mentioned in chapter 1, a module has ter-
minals of different types. Before one can create a module its terminal properties,
type and variables, must be defined. From the defined type and variables we make
separate terminals, which can be added to the module whenever the module will
be created. In this way we only have to define the terminal properties once, and
not every time a new module is created.

Cr.icaiai.J I.Itype.
Inrminal 1 I

Main Tenninal

Figure 4.2: Create a terminal

Create a new equation: Every module and connection behavior is described by
equations. From the provided equations in the GUI, equations are made with
pointers to the module or connection.

C,cate.new
GUI

Icre.icEq(eqn) m: I.Inew(eqn) .
eqiiion

_______

Main Equioe

Figure 4.3: Create an equation

Create a new module class: Given terminals and equations together with type
and linearity, a module can be created. From the equations and the variables on
the terminals, a kernel representation for this module is made. Note that not only
the main object has a kernel representation, but also every separate module (if the
behavior of the module is linear).
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C,ee a

Create a new type of connection: To connect terminals, the connection between
two terminals must be defined, using the connection constraints. Given the pro-
vided equations from the GUI and the type of the to be connected terminals, a new
type of connection is created.

c,eate a I a 0type.v.z.cq) I n:
1.1 Dcypa.v&)

_______

1 Ma,n
I 2 aL1nk(eq)

________ ________

Connazt,ou,

2 S.c(coa)

Figure 4.5: Create a connection

Insert modules in the system: After defining modules they can be inserted in
the current session, by providing the class name and a name for the module in
the current session. After inserting the module, the kernel representation of the
system will be updated with the constitutive equations of the module.
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Figure 4.4: Create a module
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Figure 4.6: Insert a module



Connect two terminals: When inserted one or more modules, their terminals can
be connected, if they are of adapted type. Afterwards the kernel representation
has to be updated, since connecting terminals imposes additional restrictions to
the variables.

Disconnect two terminals: After connecting two terminals there is a possibility
to undo this by disconnecting them.

I.ItComO
Ik(CO Tnzä.l

1.6 mn1.i.k(s)

___

ni

_

Di,con,.ct ternin.I..I GU ''4 rn 1.2

u.ndj
(

___

Icoo1
1.7 if mjsLj*) () I '.4 mLnkcon

.pd() I I.3iemLnk

1w.I
Ken,cI

Figure 4.8: Disconnect two terminals
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Remove a module from the system: When inserting modules you are able to
remove a certain module from your session.

Disconnect all the terminals of a module: When a module object is removed
form the current session, all its terminal objects will be disconnected.

Figure 4.10: Disconnect all terminals of a module
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Figure 4.9: Remove a module
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4.2.2 Behavior of the interconnected system.

The collaboration diagrams for showing the representations and calculation of the
representations are given below.

Show all the equations: These are all the equations of the modules and connec-
tions. The parameters doesn't have to be numerical values in this representation,
because of the fact that we don't need Matlab for calculating this representation.

ShO..Jlth.,J GIfl ltDYiIOjJ
equaiioes Main

U
2ihow(eq)

Figure 4.11: Show equations

Show the kernel representation: This is the kernel representation of the full
behavior defined by R()w 0. Also in this representation parameters doesn't
have to be numerical values.

Sb.. the kernel

iepirneuiJon Miii

U
2 thow(ke,nel)

Figure 4.12: Show kernel representation

From now on parameters need numerical values because we use Matlab rn-files to
calculate the desired representations.
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Show minimal kernel representation: This is the row reduced kernel represen-
tation = 0 of the full behavior, with

U()R() = [4)
]

and of full row rank and U() an unimodular matrix.

Figure 4.13: Show minimal/row reduced kernel representation

Show eliminated kernel representation: This is the row reduced kernel repre-
sentation R()w = 0 of the manifest behavior,. We use the Matlab file elimi-
nate.m to calculate this representation (compare section 2.2)

Show the elin.inged
GUI eticerneioJ rn 1.1 eh) •

keroel

________

]__Má Keroel

1.1.1 cliniflMed(k)

2 thow(kemcl)

Mml.b

Figure 4.14: Show eliminated kernel representation

Show the equation of the eliminated system: From the kernel representation of
the manifest behavior we build equations for the manifest behavior.

Figure 4.15: Show equations of eliminated kernel representation
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Show 110 representation: As discussed in section 2.4.1 the behavioral equa-
tions R(g)w = 0 of the full behavior can be written as = Q()u the
input/output form of the system, where w can be partitioned as

Iuw=I
I.y

We use Matlab for calculating P,Q and the 110 partition.

GUI IetFulII m l2opd ii

_______ _______

10

2thow0)

M.tl.b

Figure 4.16: Show 10 representation

Show external 110 representation: We saw that the full behavior can be written
in input/output form, but this can also be done for the manifest behavior.

Show IJS/0 representation: Every behavior described by R()w = 0 admits an
i/sb representation of the form

x=Ax+Bu
y=Cx+Du

with u the input, x the state and y the output (section 2.4.2).
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Figure 4.17: Show external JO representation



Show external JJSIO representation: Also for the external behavior an i/sb rep-
resentation can be calculated.

Provide properties of the system: When you build a dynamical system you
might be interested in some properties of this system. We implemented three
properties namely:

1. Controllability of the full behavior.

2. Controllability of the manifest behavior.

3. Observability of the full behavior.

See also section 2.3.2 and section 2.3.1.

Figure 4.20: Properties

In the future some properties as stability and detectability will be implemented.
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Figure 4.18: Show ISO representation

Figure 4.19: Show external ISO representation



4.2.3 Simulation.

If you want to simulate the behavior R()w = 0, you need to specify the forcing
equations

together with the initial conditions

= M()f

S()w(O) = a

Given the forcing functions f Matlab calculates the index of the the behavior, this
index relates the smoothness of the given f to the smoothness of the solution w.
If the provided f is smooth enough Matlab checks if the behavior

[R()w — 0

— M()f
is solvable for this f. If so well-posedness of the initial conditions S()w(0) = a
is calculated. When the initial conditions are well-posed we are able to simulate
the trajectories w. See also section 2.5
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Appendix A

OOP and the Universal Modeling
Language

In this section we explain the Object Oriented Programming approach using UML,
short for Universal Modeling Language. We define objects, which are essential
elements in OOP, and also classes and inheritance.

A.1 Definitions

Objects are the key to understanding object-oriented technology. You can look
around and see many examples of real-world objects: a car, a desk, the television
set, a bicycle.
These real-world objects share two characteristics: they all have state and behav-
ior. For example, dogs have state (name, colour, breed, hungry) and behavior
(barking, fetching, and wagging tail). Bicycles have state (current gear, current
pedal cadence, two wheels, number of gears) and behavior (braking, accelerat-
ing, slowing down, changing gears). But also a desk has (trivial) behavior: doing
nothing.
Software objects are modeled after real-world objects in that they too have state
and behavior. A software object maintains its state in one or more variables called
attributes. A variable is an item of data named by an identifier. A software ob-
ject implements its behavior with methods. A method is a function (subroutine)
associated with an object. You can communicate with an object by sending it a
message, a so called method call. There is no other communication possible. This
is illustrated in figure A.l. This leads to the following definition:

Definition A.!.! An object is a software bundle of variables and related methods.
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message

Figure A. 1: Method call to object

You could see objects as agents, each of them with its own speciality. The agent
is ordered to do something, the method call, and he carries out his task possibly
by asking things to other agents as well.

If you think about it, some objects have things in common. In chapter 1, for in-
stance, we encountered module classes. The members of this class share a couple
of things: they all have terminals, behavior, etc. But for every module individ-
ually, these terminals and behavior may differ. In general, objects of a certain
class possesses the same methods but a different state, although each member of a
class can have additional methods and additional attributes. This gives rise to the
following definition:

Definition A.1.2 A class is a blueprint, or prototype, that defines the variables
and the methods common to all objects of a certain kind.

This can be more generalized. Classes itself may also have things in common.
For example, we could group electrical modules, iD-mechanical modules, etc,
inducing an electrical module class, a iD-mechanical module class, etc. But they
all are modules. We call these classes subclasses.

An example. Take the class bicycles. Each bicycle object has two wheels, pedals
etc. But some bikes have gears. The bikes with gears form a subclass of the class
bicycles. A gear bike has attributes that a bike without a gear doesn't have. For
instance, the current gear attribute. The method change gear is also not present
for a general bike.
We say that members of a subclass inherit the attributes and methods. The notion
of inheritance plays an important role in Object Oriented Programming.
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A.2 UML notation
UIvIL stands for Universal Modeling Language, a visualization for 00-analysis
and 00-design where 00 stands for Object Oriented.

Figure A.2: Visualization of a class

A class is visualized by a rectangle which is divided into three sections. The first
section contains the name of the class. The second section contains the attribute
identifiers and the third section the identifiers of methods. Most literature mix up
the concept of attribute identifier and attribute. The same holds for methods.
Subclasses are visualized as follows:

Figure A.3: Gen-Spec structure

Class Al and A2 are subclasses of class A. They inherit all attributes and methods
defined in class A and they have additinal attributes and/or methods.
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There is also this notion of whole-part relation. This simply means that an
object is part of another object. For example, terminals are part of a module.
UML-notation:

Figure A.4: whole-part relation

The symbols in this figure reflects the following: ml objects of class Al are part
of ni objects of class A, etc. This symbols are, for instance, nonnegative integers.
But also other symbols are used: * means zero or more, + means 1 or more.

We could ask ourselves how these object interact with eachother. In UML this
is depicted with collabotation-diagrams. Such a diagram shows the evolution ofa
message call to an object, this is called an input event. This object itself can send
a message to another object, and so on.

Figure A.5: collaboration diagram
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